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Overview


[image: _images/overview.png]

Fig. 1 Xena3918 overview



This is the user manual for Xena3918. Xena3918 is a Windows application that enables you to perform advanced network tests according to the RFC 3918[#1] using one or more of the Xena test equipment chassis.

The Xena3918 application features the following capabilities:


	Enables the user to create, edit and execute test configurations using Xena Networks test equipment in accordance with RFC 3918[#2] standard.


	Full support for all test-types specified in RFC 3918[#3].


	Ability to partially enable one or more of the test types.


	Support for IPv4 and IPv6.


	Support for all IGMP/MLD versions.


	Support for multiple ValkyrieBay and ValkyrieCompact test chassis.


	Ability to flexibly define the protocol layers supported by the test (Ethernet, Customer and Service VLANs, IP and UDP).


	Test reports can be created in either PDF or XML format or both.


	Extensive configuration options to fine-tune the tests.





Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc3918.html



[#2]
https://datatracker.ietf.org/doc/html/rfc3918.html



[#3]
https://datatracker.ietf.org/doc/html/rfc3918.html





            

          

      

      

    

  

    
      
          
            
  
Installation

Xena3918 is a Windows desktop application compatible with Windows 8 and later versions.

It comes pre-installed as an integral component of the standard Xena software release package, which is available for download from this source[#1].

Following the installation, you can locate a shortcut to the application in the Start ‣ Programs ‣ Xena Network menu, and additionally (if you opted for this during the setup process), on your desktop.


[image: ../_images/installation.png]


Footnotes



[#1]
https://xenanetworks.com/l23-downloadsw/





            

          

      

      

    

  

    
      
          
            
  
Available Tests

RFC 3918[#1] defines the following test types, which are separated into a number of functional groups:


Forwarding and Throughput

This group contains the following tests which are all fully supported by the Xena3918:


	Aggregated Multicast Throughput

This test determines the maximum zero-loss throughput rate for N destination interfaces of the same multicast groups. It is similar to the Throughput test from RFC 2544[#2] but uses multicast traffic exclusively.



	Mixed Class Throughput

This test determines the maximum zero-loss throughput rate of a DUT/SUT when both unicast class frames and multicast class frames are offered simultaneously to a fixed number of interfaces as defined in RFC 2423[#3]. It is similar to the Throughput test from RFC 2544[#4] but uses a mix of unicast and multicast traffic.



	Scaled Group Forwarding Matrix

This test determines the Forwarding Rate as a function of tested multicast groups for a fixed number of tested DUT/SUT ports. It is similar to the Loss test from RFC 2544[#5]. The group also contains these tests which are not supported by the Xena3918 as present:







Forwarding Latency

This group contains the following tests:


	Multicast Latency.


	Min/Max Multicast Latency.




These two tests have been combined into one test in the Xena3918 as both tests can be executed by the same test procedure.

The tests produces a set of multicast latency measurements from a single, multicast ingress interface of a DUT/SUT through multiple, egress multicast interfaces of that same DUT/SUT. The test is similar to the Latency test in RFC 2544[#6] but measures exclusively the latency between the single source port and the destination port(s).



Overhead

This group contains the following tests:


	Group Join Delay.


	Group Leave Delay.




These two tests have been combined into one test in the Xena3918 as both tests can be executed by the same test procedure.

The Join test determine the time duration it takes a DUT/SUT to start forwarding multicast frames from the time a successful IGMP group membership report has been issued to the DUT/SUT. The Leave test determine the time duration it takes a DUT/SUT to cease forwarding multicast frames after a corresponding IGMP Leave Group message has been successfully offered to the DUT/SUT.



Capacity

This group contains the following tests which are all fully supported by the Xena3918:


	Multicast Group Capacity.




The test determine the maximum number of multicast groups a DUT/SUT can support while maintaining the ability to forward multicast frames to all multicast groups registered to that DUT/SUT.



Interaction

This group contains the following tests which are all fully supported by the Xena3918:


	Forwarding Burdened Group Join Delay


	Forwarding Burdened Multicast Latency




These tests are similar to the Group Join Delay and Multicast Latency tests but with additional meshed unicast traffic being sent through the DUT from a set of separate ports.



Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc3918.html



[#2]
https://datatracker.ietf.org/doc/html/rfc2544.html



[#3]
https://datatracker.ietf.org/doc/html/rfc2423.html



[#4]
https://datatracker.ietf.org/doc/html/rfc2544.html



[#5]
https://datatracker.ietf.org/doc/html/rfc2544.html



[#6]
https://datatracker.ietf.org/doc/html/rfc2544.html





            

          

      

      

    

  

    
      
          
            
  
Getting Started

This section explains how to get started using the Xena3918 to execute a few simple tests. The test configuration will consist of one multicast source port and two multicast destination ports. It will not use any unicast traffic ports.


	Start the Xena3918 application.


	Press the Add Chassis button in the menu bar. Enter the address and password of the Xena chassis you want to use. Press the OK button and wait until the application has successfully connected to the chassis.


	Locate the three ports you want to use in the left-most Physical Ports tree view, right-click them and choose the Add Port to Test Configuration. You can either select them one by one or perform a multiple-selection by holding down the Ctrl while selecting port ports with the mouse.


	Change to the Selected Ports panel. You should now see the three ports you have chosen to include in the test:






	Set the role of the port you want to use as the multicast source port to MC Source.


	Set the role of the two other ports to MC Destination.


	Set the IP Address, Routing Prefix and Gateway Address for each of the ports.








	Change to the Test Configuration panel.






	Leave the options in the General Test Options subpanel at their default values.


	Change to the Test Types Selection and Configuration subpanel. Ensure that only the Group Join/Leave Delay, Aggregated Multicast Throughput and Multicast Latency tests are enabled (checked). Leave the options for all enabled subtests at their default values.








	Change to the Multicast Configuration panel.






	Check the following options in the Multicast Flow Definition subpanel:


	Ensure that the IGMP/MLD Version is set to a version supported by your DUT.


	Check that the Start Address in the Multicast Address Range section is supported by your DUT. You will only need a single multicast group address for the selected tests.


	Check that the Packet Rate option is set to a value which is sensible for your DUT.






	Check that the selected protocol header segments in the Protocol Segments subpanel are sensible for your DUT. Note the following default field assignments:


	The Ethernet Source MAC address will be set to the MAC address of the port.


	The Ethernet Destination MAC address will be set to the multicast MAC address according to RFC 1112 #section-6.4[#1].


	The Source IP address wil be set to the address specified for the port.


	The Destination IP address will be set to the multicast group address.












	Save your configuration by clicking the Save button in the toolbar or by pressing Ctrl-S on the keyboard. Provide a filename for the configuration when asked.


	Start the test by clicking the Start button in the toolbar.


	The Result Data panel at the bottom should not be shown automatically and will allow you to follow the progress of the tests.


	When all selected tests have completed the final PDF report should be opened in your default PDF viewer application.






	Multicast Background

	Step-By-Step Guide
	Add Chassis

	Add/Configure Port/s

	Protocol Segment Profiles

	Multicast Configuration

	Unicast Configuration

	Test Configuration

	Reporting

	Save and Start










Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc1112.html#section-6.4





            

          

      

      

    

  

    
      
          
            
  
Multicast Background

Multicasting data optimizes how is sent through a network. Often data is sent from one point to another (Unicast)


[image: ../_images/mc_bk_1.png]

If numerous end-users want to receive information from the same source at the same time, the bandwidth required to send the information through the network can be reduced.

This is achieved by IP Multicast. Information is sent as one stream as far as possible before splitting it to the intended recipients.


[image: ../_images/mc_bk_2.png]

Broadcast is a third option for routing data through the network; in this case the information is sent to all users in a broadcast domain.


[image: ../_images/mc_bk_3.png]

With multicast, the recipients of the information can be limited to only those that are actually interested in receiving the information.

Multicast is typically used for streaming application like:


	Scheduled (not on-demand) IP Television


	Video advertising


	Multi-point video conferencing


	Stock-quote applications


	Simultaneous distribution of large files to a number of computers




IP multicast enables real time communication between a source and a group of recipients (destinations) through an IP network.


	Recipient can dynamically enter an IP multicast group by sending a Join message, and drop out of the group again by sending a Leave message


	Multicast address range (IPv4): 224.0.0.0 to 239.255.255.255





[image: ../_images/mc_bk_4.png]

The Join/Leave process is handled by:


	Internet Group Management Protocol (IGMP) for IPv4


	Multicast Listener Discovery (MLD) protocol for IPv6




To send data packets to an IP multicast group, the source use the multicast group address as destination IP address in data packets


	Multicast group addresses are allocated dynamically.


	There is no need for sources to register anywhere to send data packets to an IP multicast group, and sources don’t have to join the group through IGMP/MLD




Several sources can send data into an IP multicast group.


	IP multicast actually supports both point to multi-point and multi-point to multi-point communication.


	IP multicast does not require that the multicast group source knows the recipients in the group




IP network elements (e.g. switches, routers) transport data packets from the source to the IP multicast group recipients. IP network elements replicate data packets when required, but will use the IP network efficiently as a data packet is only sent once over a given link in the network, even if it will end up at numerous recipients


Footnotes



            

          

      

      

    

  

    
      
          
            
  
Step-By-Step Guide


Add Chassis


[image: ../_images/step_by_step_1.png]

Click the Add Chassis button.


[image: ../_images/step_by_step_2.png]

Enter the IP of the Management port under Chassis Address. Use xena as default Chassis Password.



Add/Configure Port/s


[image: ../_images/step_by_step_3.png]

Select the Port(s) you need to use.


[image: ../_images/step_by_step_4.png]

Choose the Port/s you want to configure.


	Port Roles





The following rules apply when assigning roles to ports:

There must be exactly one Multicast Source (MC Source) port. The MC Source port is the port that acts as the multicast server and transmits the multicast traffic to the multicast groups.
There must be at least one Multicast Destination (MC Destination) port. The MC Destination ports act as the multicast clients and will receive the traffic sent to the multicast groups.
If the selected tests require burdening traffic there must be at least two Unicast Burdening (UC Burden) ports. Burdening ports are used to emulate additional unicast traffic to burden the DUT.





	Physical Port Properties





Inter-Frame Gap



	Set to 20 -> 12B (Minimum allowed by Ethernet at 100% load)


	(12+8B Preamble equals 20B)


	Can be set to 16B to achieve >100% load for port pressure testing


	Values range between 16B-20B







Adjust PPM



	Specifies an optional speed reduction on the transmit side of the port, expressed as a ppm value.







Enable PAUSE mode



	This means enable Flow Control on this port







Latency offset



	Used to automatically eliminate transceiver + cable latency.











See also

Check Selected Ports Panel for details.





Protocol Segment Profiles


[image: ../_images/step_by_step_5.png]


	Add new profile.


	Add additional headers.


	Choose Segment.





See also

Check Protocol Segment Profile Panel for details.





Multicast Configuration

Multicast configuration applies all multicast traffic.


[image: ../_images/step_by_step_6.png]


See also

Check Multicast Configuration Panel for details.





Unicast Configuration

Unicast configuration applies only unicast traffic.


[image: ../_images/step_by_step_7.png]


See also

Check Unicast Configuration Panel for details.





Test Configuration


[image: ../_images/step_by_step_8.png]

Configure the frame sizes you want to use for the test. This applies to both multicast and unicast traffic.


See also

Check General Test Options for details.




[image: ../_images/step_by_step_9.png]

Select and configure the test you want to run.


See also

Check Test Type Selection and Configuration for details.




See also

Check Available Tests to understand what each test does.





Reporting


[image: ../_images/step_by_step_10.png]

Select the report format you want to generate.


See also

Check Reporting Options Panel for details.





Save and Start

Start the test. Xena3918 will automatically reserver the ports and ask you to save the test configuration.



Footnotes



            

          

      

      

    

  

    
      
          
            
  
General Panels

The main Xena3918 application screen is shown in the image below.


[image: ../_images/general.png]

Fig. 2 Xena3918 application screen




	At the top you find a menu bar with accesses various application-level functions. You also find a toolbar with quick shortcuts to the most used functions.


	At the left you find a tree view named Physical Ports showing the available Xena chassis, modules and ports.


	At the right you find a tabbed view with various application panels. These are explained below.





Application Panels


	Start Page

The default main page shown to the user. This page contains a brief guide to assist you in creating an initial test configuration. You can close this panel once you feel that it is no longer useful to you.



	Selected Ports

This panel allows you to include Xena test ports in your test and to configure the behavior of these ports. You select the ports in the Physical Ports view and drag them to the Selected Ports panel to include them in the test.



	Test Configuration

This panel controls all aspects of the Test Configuration, including the selection of the actual tests to perform.



	Multicast Configuration

This panel controls all aspects of the multicast flow configuration.



	Unicast Configuration

This panel controls all aspects of the unicast flow configuration. The Unicast configuration is used in a number of the available tests as background traffic.



	Reporting Options

This panel control all aspects of the reporting function.







Status Panel


	Result Data

This panel displays the test data in a grid view.



	Configuration Errors

This panel displays any configuration errors detected in your configuration when attempting to start a test.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Physical Ports Panel

This panel displays all available ports on the currently connected Xena chassis. It is possible to connect to multiple Xena chassis at the same time.


[image: ../_images/phy_ports_panel.png]

Fig. 3 Physical Ports Pane



It also allows you to perform the following actions:


	View the current sync (link) and traffic state of the ports.


	View the ownership of the ports, i.e. are the ports reserved and by whom.


	Request or relinquish ownership of ports.


	Determine which ports will be used in the multicast tests.




You can reserve or relinquish ownership of a port by right-clicking on it and selecting the appropriate action.


Note

Note that the Xena3918 will automatically reserve ownership of used ports when a test is started.




Footnotes



            

          

      

      

    

  

    
      
          
            
  
Selected Ports Panel

This panel displays the ports that have been actively selected for use in the test configuration.


[image: ../_images/selected_ports_panel.png]


	Port Name

The name (ID and type) of the port.



	MC Port Role

The role this port plays in the overall test configuration. See below for a description of the rules for port role assignment.



	Port Speed

The physical port speed to use in the test. Normally this should be left at the default AUTO value, but certain DUTs require that the port speed is fixed to a specific rate.



	IP Address

The IP address that you want to use for the port. All ports in the configuration need an IP address.



	Prefix

The decimal network prefix for the address.



	Gateway Address

The gateway address for the assigned IP address. Usually this will be the address of the DUT port which the test port is connected to.






Port Roles

The following rules apply when assigning roles to ports:


	There must be exactly one Multicast Source (MC Source) port. The MC Source port is the port that acts as the multicast server and transmits the multicast traffic to the multicast groups.


	There must be at least one Multicast Destination (MC Destination) port. The MC Destination ports act as the multicast clients and will receive the traffic sent to the multicast groups.


	If the selected tests require burdening traffic there must be at least two Unicast Burdening (UC Burden) ports. Burdening ports are used to emulate additional unicast traffic to burden the DUT.






Adding A Port

To include a port in the test configuration, perform one of the following two actions:


	Select the Selected Ports panel. Then select the port in the Physical Ports panel and drag it to the Selected Ports panel.


	Right-click the port in the Physical Ports panel and select the Add Port to Test Configuration menu option.






Removing A Port

To stop using one or more ports in a test perform one of the following two actions:


	Select the port(s) you want to remove from the test in the Selected Ports panel. Then you can either press the Remove Port button at the lower right or right-click on the port and select the Remove Port menu item.


	Right-click the port in the Physical Ports panel and select the Remove Port from Test Configuration menu option.






Footnotes



            

          

      

      

    

  

    
      
          
            
  
Test Configuration Panel

This panel contains options that control the actual execution of the tests. It also allows you to select exactly what tests to run.



	General Test Options

	Test Type Selection and Configuration
	Group Join/Leave Delay Options
	Common Options

	Delay Settings

	Rate Settings





	Multicast Group Capacity Options
	Common Options

	Multicast Group Count

	Delay Settings

	Rate Settings





	Aggregated Multicast Throughput Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings





	Scaled Group Forwarding Matrix Options
	Common Options

	Multicast Group Count

	Delay Settings

	Rate Settings





	Mixed Class Throughput Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings





	Multicast Latency Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings





	Burdened Group Join Delay Options
	Common Options

	Delay Settings

	Rate Settings





	Burdened Multicast Latency Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings














Footnotes



            

          

      

      

    

  

    
      
          
            
  
General Test Options


[image: ../_images/general_test_options.png]

Fig. 4 General Test Options



This sub-panel contains general options that affect all selected tests.


	Packet Sizes

Using this option, you can select the packet sizes to use in the test. If you select one of the options from the Fixed Sizes Per Trial section the tests will be repeated for each packet size selected. If you select one of the options from the Varying Sizes Per Trial only one trial will be executed.



	Latency Mode

Determines the mode used to measure latency.



	Latency Unit

Determine the unit which is used to report latency measurements.



	Jitter Unit

Determine the unit which is used to report jitter measurements.



	Toggle Sync State

If selected the port sync states will be toggled off and on between each trial.



	Use Micro-TPLD if needed

The normal Xena test payload (TPLD) section takes up 20 bytes and is used for various purposes, such as latency measurements, loss and misordering monitoring, payload integrity, etc. Due to this test payload it may be impossible to make room for protocol headers such as IPv4+UDP for smaller frame sizes (e.g. ~64 byte). By enabling this option you permit Xena3918 to use the smaller micro-TPLD if needed by the current frame size. The consequence of this will be that realtime monitoring of packet loss is no longer possible. Note that Xena3918 will only use the micro-TPLD for a test run if the current frame size requires it. If you for instance use the default IEEE packet size distribution you may encounter that the micro-TPLD is only used for 64 byte packets but not for the other packet sizes.



	Sync State Off Period

The number of seconds to keep the port sync state off.






Footnotes



            

          

      

      

    

  

    
      
          
            
  
Test Type Selection and Configuration


[image: ../../_images/test_type_selection_config.png]

Fig. 5 Test Type Selection and Configuration



This sub-panel allows you to select which tests to perform and to configure the options for each test. The tests are grouped according to RFC 3918[#1].

To enable a test just make sure that the checkbox next to the test name is checked.

To configure a test select the test in the tree view and set the options in the panel to the right.



	Group Join/Leave Delay Options
	Common Options

	Delay Settings

	Rate Settings





	Multicast Group Capacity Options
	Common Options

	Multicast Group Count

	Delay Settings

	Rate Settings





	Aggregated Multicast Throughput Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings





	Scaled Group Forwarding Matrix Options
	Common Options

	Multicast Group Count

	Delay Settings

	Rate Settings





	Mixed Class Throughput Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings





	Multicast Latency Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings





	Burdened Group Join Delay Options
	Common Options

	Delay Settings

	Rate Settings





	Burdened Multicast Latency Options
	Common Options

	Multicast Group Count Selection

	Delay Settings

	Rate Settings










Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc3918.html





            

          

      

      

    

  

    
      
          
            
  
Group Join/Leave Delay Options


[image: ../../_images/group_join_leave_delay.png]

Fig. 6 Group Join/Leave Delay Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Delay Settings


	Traffic-to-Join Delay

The number of seconds to wait between starting the multicast traffic on the source port and sending the Join requests on the destination ports.



	Leave-to-Stop Delay

The delay between calculating the Join latency and sending the Leave request.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Step Rate

If present this option is used to increment the rate percentage when iterating from a starting to a maximum rate.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Multicast Group Capacity Options


[image: ../../_images/mc_group_capacity.png]

Fig. 7 Multicast Group Capacity Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Multicast Group Count


	Start

Group count start value.



	End

Group count end value.



	Step

Group count step value.







Delay Settings


	Join-to-Traffic Delay

The number of seconds to wait between sending the Join requests on the destination ports and starting the multicast traffic on the source port.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Step Rate

If present this option is used to increment the rate percentage when iterating from a starting to a maximum rate.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Aggregated Multicast Throughput Options


[image: ../../_images/aggr_mc_throughput.png]

Fig. 8 Aggregated Multicast Throughput Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Multicast Group Count Selection


	Count List

A comma-separated list of the multicast group counts to use for each iteration.



	Count Range

An incrementing list from start to end with the specified step size.







Delay Settings


	Join-to-Traffic Delay

The number of seconds to wait between sending the Join requests on the destination ports and starting the multicast traffic on the source port.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Minimum Rate

If present this option denotes the minimum rate in percent of the overall rate configured in the Multicast Stream panel.



	Resolution

If present this option denotes a minimum difference between rates which will be used to stop the iteration.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Scaled Group Forwarding Matrix Options


[image: ../../_images/scaled_group.png]

Fig. 9 Scaled Group Forwarding Matrix Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Multicast Group Count


	Start

Group count start value.



	End

Group count end value.



	Step

Group count step value.







Delay Settings


	Join-to-Traffic Delay

The number of seconds to wait between sending the Join requests on the destination ports and starting the multicast traffic on the source port.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Step Rate

If present this option is used to increment the rate percentage when iterating from a starting to a maximum rate.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Mixed Class Throughput Options


[image: ../../_images/mixed_class.png]

Fig. 10 Mixed Class Throughput Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Multicast Group Count Selection


	Count List

A comma-separated list of the multicast group counts to use for each iteration.



	Count Range

An incrementing list from start to end with the specified step size.







Delay Settings


	Join-to-Traffic Delay

The number of seconds to wait between sending the Join requests on the destination ports and starting the multicast traffic on the source port.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Minimum Rate

If present this option denotes the minimum rate in percent of the overall rate configured in the Multicast Stream panel.



	Resolution

If present this option denotes a minimum difference between rates which will be used to stop the iteration.



	Unicast Traffic Ratio

If present this option denotes the percentage of the overall rate configured in the Multicast Stream panel to be used for unicast traffic.






Note

Note that the unicast rate will be added to the configured multicast rate. So if the multicast rate has been set to e.g. 10% and the UC traffic ratio is set to 50% the total rate for the port will be 10% + (50% of 10%) = 15%.





Footnotes



            

          

      

      

    

  

    
      
          
            
  
Multicast Latency Options
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Fig. 11 Multicast Latency Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Multicast Group Count Selection


	Count List

A comma-separated list of the multicast group counts to use for each iteration.



	Count Range

An incrementing list from start to end with the specified step size.







Delay Settings


	Join-to-Traffic Delay

The number of seconds to wait between sending the Join requests on the destination ports and starting the multicast traffic on the source port.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Step Rate

If present this option is used to increment the rate percentage when iterating from a starting to a maximum rate.
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Burdened Group Join Delay Options
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Fig. 12 Burdened Group Join Delay Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Delay Settings


	Traffic-to-Join Delay

The number of seconds to wait between starting the multicast traffic on the source port and sending the Join requests on the destination ports.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Step Rate

If present this option is used to increment the rate percentage when iterating from a starting to a maximum rate.



	Unicast Traffic Ratio

If present this option denotes the percentage of the overall rate configured in the Multicast Stream panel to be used for unicast traffic.






Note

Note that the unicast rate will be added to the configured multicast rate. So if the multicast rate has been set to e.g. 10% and the UC traffic ratio is set to 50% the total rate for the port will be 10% + (50% of 10%) = 15%.
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Burdened Multicast Latency Options
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Fig. 13 Burdened Multicast Latency Options




Common Options


	Duration

The duration in seconds of the time used in each trial for the actual measurement. This does not include the test setup and teardown phases so the total duration of a test will be longer.



	Iterations

The number of times a test is repeated using the same set of variable parameters (packet size, rate, etc.)







Multicast Group Count Selection


	Count List

A comma-separated list of the multicast group counts to use for each iteration.



	Count Range

An incrementing list from start to end with the specified step size.







Delay Settings


	Join-to-Traffic Delay

The number of seconds to wait between sending the Join requests on the destination ports and starting the multicast traffic on the source port.







Rate Settings


	Initial Rate

If present this option denotes the initial rate in percent of the overall rate configured in the Multicast Stream panel.



	Maximum Rate

If present this option denotes the maximum rate in percent of the overall rate configured in the Multicast Stream panel.



	Step Rate

If present this option is used to increment the rate percentage when iterating from a starting to a maximum rate.



	Unicast Traffic Ratio

If present this option denotes the percentage of the overall rate configured in the Multicast Stream panel to be used for unicast traffic.






Note

Note that the unicast rate will be added to the configured multicast rate. So if the multicast rate has been set to e.g. 10% and the UC traffic ratio is set to 50% the total rate for the port will be 10% + (50% of 10%) = 15%.
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Multicast Configuration Panel
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Fig. 14 Multicast Configuration Panel



This panel contains configuration options that control the generation of multicast traffic.


Multicast Protocol Profile and Version


	Protocol Profile

The protocol segment profile to use for the multicast traffic.



	IGMP/MLD Version

Specifies the IGMP or MLD version to use. Note that the IP version is implicitly selected in the Protocol Profile option described above.







Multicast Address Range


	Start Address (IPv4)

The starting address to use when allocating a multicast group address sequence. Only valid if IPv4 is selected through the protocol profile.



	Start Address (IPv6)

The starting address to use when allocating a multicast group address sequence. Only valid if IPv6 is selected through the protocol profile.



	Step Value

The step value used to increment the address when generating a multicast group address sequence.







Protocol Registration Handling


	Join Refresh Interval

The interval in seconds with which the join requests will be retransmitted. This is useful for longer-running tests where the router may otherwise timeout the individual learning requests.



	Join/Leave Rate

The maximum rate with which the IGMP Join or Leave packets are sent. This is used to spread out the request transmission to prevent the DUT from being overwhelmed and drop requests.



	Use Source Address

If selected the multicast address will be added as a source address to the IGMPv3/MLDv2 Group Record in the Join/Leave requests. If not selected the Group Records will not contain any source addresses. See RFC 3376 #section-4.2.9[#1] for details.



	Leave to AllRouters

If selected, Leave Group messages are sent to the all-routers multicast group (224.0.0.2) If not selected Leave Group messages are sent to the multicast group address







Test Payload


	Payload Type

The type of test payload in the packets generated by the MC source port.



	Pattern

If the payload type has been set to “Pattern” you can specify the pattern here.







Packet Rate


	Fraction

This option allows you to specify the overall rate used for the multicast stream as a percentage of the physical port rate.



	Packet/sec

This option allows you to specify the overall rate used for the multicast stream as a packets per second value.







Footnotes



[#1]
https://datatracker.ietf.org/doc/html/rfc3376.html#section-4.2.9





            

          

      

      

    

  

    
      
          
            
  
Unicast Configuration Panel
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Fig. 15 Unicast Configuration Panel



This panel contains configuration options that control the generation of unicast traffic.


Test Payload


	Payload Type

The type of test payload in the packets generated by the MC source port.



	Pattern

If the payload type has been set to “Pattern” you can specify the pattern here.







Footnotes



            

          

      

      

    

  

    
      
          
            
  
Protocol Segment Profile Panel

This sub-panel defines the protocol segments used for the multicast traffic generated by the source port. You can add, remove and rearrange segments as you please.

Note the following default field assignments:


	The Ethernet Source MAC address will be set to the MAC address of the port.


	The Ethernet Destination MAC address will be set to the multicast MAC address according to RFC 1112, section 6.4.


	The Source IP address will be set to the address specified for the port.


	The Destination IP address will be set to the multicast group address.





Available Profiles List

The list view at the top show all defined profiles.
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Fig. 16 Protocol segment profiles




Managing Profiles

You can create and delete profiles to match the need of the current test scenario. To create a new profile press the Add Profile button. To delete a profile select it in the list view and press the Remove Profile button.

You can however not delete a profile that is currently being used by a test port. You can see the number of test ports currently using a profile in the Use Count column in the list view at the top.To delete a profile that is in use you will first have to reassign all ports currently using that profile to another profile.



Default Profiles

When you create a new Xena3918 configuration it will be populated with a number of default profiles. You can however freely modify and even delete one or more of the default profiles.

If for some reason you want to restore the default profiles you can press the Restore Default Profiles button. This will unconditionally remove all current profiles (also those that are in use) and restore the default set. All test ports will be associated with the first default “Ethernet-only” profile.




Profile Editor

You can edit each profile by selecting it in the top list view and using the tree view control below.


Add and Remove Segment Headers

To add a new segment header press the Add button in the Segments section to the right. You will then be presented with a dialog listing all built-in segment types from which you can select one or more types to be included. If you want to use a segment not currently supported by the Xena3918 you can add a raw segment and specify the length in bytes. You can then afterwards edit the values in the resulting segment using the hex editor at the bottom.

You can remove one or more segments by selecting them and pressing the Remove button in the Segments section. You can change the order in which the segment headers appear by using the Move Up/Down buttons.

The Xena3918 will automatically adjust the value of any standard “”next-protocol” field (such as the EtherType field) in the segment headers when other segments are added, removed or moved.



Editing Field Values

The segment editor provides a tree view similar to the one found in the Wireshark protocol analyzer. You can thus expand each segment branch to view and optionally modify the various field values. Each field title is preceded with a small icon indicating the type of field value (decimal, hexadecimal, binary or IPv4/IPv6 address).

Certain fields, such as the EtherType, are associated with a set of commonly used named values. These can be selected in the Named Values column. You are however free to enter any value you want in the Raw Value column.

You can also edit the hex value of the segment headers directly using the hex editor at the bottom if you are so inclined.



MAC and IP Addresses

The address fields in the Ethernet and IP section headers will usually be overridden by the Xena3918 when the test streams are created:

The Source MAC (SMAC) address field in the first Ethernet segment will be set to the MAC address of the source port.

The Destination MAC (DMAC) address field in the first Ethernet segment will be set to the MAC address of the destination port. If an IP segment has been defined and a gateway IP address is defined for a source port, the Xena3918 will however attempt to resolve the MAC address of the gateway using ARP or NDP and wil then use this MAC address as the DMAC.

The IP Source/Destination Address fields in the IP segment header will be set to the values configured on the ports, as explained in the Selected Ports panel section above.

This replacement will however only be performed if you leave the fields at their default (all-zeros) value. If you specify anything else this value will be used instead.




Modifiers

It is possible to attach a modifier definition to one or more fields. A modifier will exercise the field with various values during the test and can be used to emulate a certain dynamic behavior. Modifiers are often used to exercise either the VLAN PCP or the IP DHCP fields. Alternatively one could apply modifiers to address fields like the DMAC field or the source or destination IP address fields.


Adding a Modifier

To add a modifier to a field simply select the field and press the Add Modifier button in the command panel to the right or right-click and select the Add Modifier popup menu option. A Create New Modifier dialog will now be shown. The content of the dialog will depend on the type of field. Most fields will use the Basic Modifier dialog shown below to the left. If the selected field is an IP address the IP Modifier dialog shown below to the right will be used instead.
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Fig. 17 Basic modifier
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Fig. 18 IP modifier



Fill in the various field values and press the OK button to add the modifier to the field. Once a modifier has been added to a field this will be indicated by a small blue M icon as shown in the screenshot above.



Editing a Modifier

To edit an existing modifier either select the field and press the Edit Modifier button in the command panel to the right, or right-click and select the Edit Modifier popup menu option. You will see the same dialog as was used to create the modifier.



Removing a Modifier

If you want to remove a modifier from a field simply select the field and press the Remove Modifier button in the command panel to the right, or right-click and select the Remove Modifier popup menu option.



Limitations

There is a limitation on the maximum number of modifiers that can be defined for each test stream. The limitation is specific for the test module type to which the port belong. Refer to the Xena Test Module Comparison Page for further details.




Value Ranges
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Fig. 19 Value Ranges



A Value Range is intended to exercise one or more fields in a Xena3918 protocol segment profiles with varying values. It is kind of similar to the hardware modifier explained above, with the following differences:


	A Modifier is handled by hardware and varies a field value between packets on the same stream.


	A Value Range is handled by software and varies a field value between different streams. All packets on the same stream have the same value.


	A Value Range is defined on a field in a protocol segment profile, just like a modifier. It will then be used for all streams created on a port which is assigned this profile.


	Value ranges can be used for both normal single-stream and advanced multi-stream scenarios. For normal scenarios it is most applicable for mesh configurations where multiple streams will be created on each port.




There is no limit to the number of values ranges added to a configuration. It is also possible to add both a modifier and a value range to a field. Whether that would yield usable results is unclear but it might be useful for larger fields.



PCAP Import

You can import the protocol segment structure from a PCAP file captured using Wireshark or any other capture application capable of generating a standard PCAP file. If the file contains multiple packets Xena3918 will display a list allowing you to select the desired packet.

Xena3918 will attempt to decode the packet and display the known protocol headers and their fields. Any unknown fields will be displayed as a raw segment. As there are limitations in the max.size of a custom segment the import may not be possible in some cases. The import dialog will inform you about this if the situation arises.
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Reporting Options Panel
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Fig. 20 Reporting Options Panel



The Reporting tab contains a number of options that affect the way reports are generated for the test.


Identification

This section contains a number of options that can help identify the test context.


	Customer Name

The name of the customer for which the test is performed.



	Customer Service/Access Id

These two options allow you to provide details about the network circuits you are testing.



	Comments

Allows you to provide any multi-line comments for the test configuration.







Report Generation

This section contains options that affect the way reports are generated.


	Report Filename Prefix

Specifies the prefix for the report filename.



	Append Timestamp to Filename

If checked a timestamp on the form <YYYYMMDD-HHMMSS> is appended to the filename prefix.



	Include Graphs in Report

If checked the report will include bar charts showing the test results. This is only applicable for PDF type reports.







Report Formats

This section allows you to select which types of reports will be generated. You can enable several types. The generated report files will be given a file extension that matches the selected type, i.e. “.pdf” for PDF files and so forth.



XML Report Specification

You can find the specification for the XML Report here.
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Configuration Errors Panel

This panel will show any configuration errors detected by the program when you attempt to execute a configuration. If any such errors are found the panel will be shown and the execution attempt will be aborted. You will have to correct any reported errors before the program will allow you to execute the configuration.


[image: ../_images/config_errors.png]

Fig. 21 Configuration errors panel



Each error will be shown in a separate line in the panel. If you double-click on an error message you will be taken to the relevant configuration panel that will allow you to correct the error.

This panel is by default found in the lower auto-hiding panel group. By “auto-hiding” we mean that the panel is initially hidden but will popup either if the panel tab is clicked or if the Xena3918 program decides that it is necessary to direct the attention of the user to the panel. You can make the panel visible always by clicking the little “pin” icon in the top-right of the panel header.
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Application Settings

The Xena3918 application features a number of application-level settings which are valid for all test configurations. These can be accessed in the Options menu item as shown in the figure below.


	Set Username

Allows you to specify the username used when logging in to the Xena testers. The default value will be your Windows username (shortened to 8 characters if longer).



	Ask to Relinquish Ports

If checked the Xena3918 will prompt you when you try to use a port which is currently reserved by someone else. If unchecked the Xena3918 will unceremoniously relinquish the port and reserve it in your name.



	Open Last Configuration On Start

If checked the configuration you had open when you last closed the application will automatically be opened the next time you start the application.



	Set Reports Path

Allows you to specify a different location for the generated reports. The default location is <ProgramData>/XenaNetworks/Xena3918/Reports. The location of <ProgramData> varies between versions of Windows but can be obtained by inspecting the environment variable ProgramData.



	Set Tester Company Name

Allows you to set the name of the company performing the tests. The default value is Xena Networks.



	Set Tester Company Logo File

Allows you to specify the path to an image file which will be used as the logo in the reports. The default logo is the Xena Networks logo. The image can be in PNG or JPG format. It should have the approximate dimensions of 150 x 60 pixels and be set to a DPI of 96.



	Open Report in Associated Viewer

If checked the Xena3918 will attempt to open the generated report in the associated viewer. This is currently only applicable for PDF reports. This requires that a suitable PDF viewer (such as the Adobe Acrobat Reader) is installed on your PC.
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Troubleshooting

This section contains some guidelines when you encounter a problem with Xena2544, Xena2889, Xena3918, Xena1564, and XenaManager and want to obtain help from your support representative.


Basic Instructions

This section explains how you should report a problem to your support representative.


Describe the Problem

To enable fast resolution of your problem we request that your support request contains the following information:


	Name and version of the Xena test software used (the version can be seen in the main title bar)


	A description of what you are trying to do with the software.


	If the software misbehaved please describe what you actually encountered and you expected instead.


	Screenshots of any error situation.


	The test configuration file for the application (contained in the support archive).


	Any debug log files for the application (contained in the support archive).






Create a Support Information Archive


[image: ../_images/help.png]

The Xena test applications include a menu entry called Create Support Information Archive which will create a compressed ZIP archive containing both the currently loaded configuration file and the content of the Logs and Settings directories. This file can then be emailed to your support representative.

For the Xena2544 and similar test applications this menu entry is located in the Help menu. For the XenaManager application it is located in the Tools ribbon menu.


Note

For the Xena2544 and similar test applications it is important that the configuration file used when the problem was detected is loaded when the support archive is generated. Otherwise the configuration file will not be part of the archive.





Attach Screenshots

Screenshots are a great and easy way of communicating what you see on the screen. To obtain a screenshot of a running program and send it to Xena support perform the following actions:


	Point your mouse inside the program window.


	Press the Alt-PrintSc keys simultaneously.


	Switch to your email program and start a new email message.


	Press Ctrl-V or select Paste from the menu (most likely the Edit menu) to insert the screenshot into the email.







Additional Details

This section goes into a bit more detail about the various items contained in the Xena Support Archive mentioned above.


Configuration Files

The Xena test applications keeps their configurations in special files with an application-specific extension. The extensions used are as follows:


	Xena2544:      .x2544


	Xena2889:      .x1564


	Xena3918:      .x3918


	Xena1564:      .x1564


	XenaManager: .xmcfg




The configuration files will be located in a common Xena data directory on your PC. More specifically they will be located in the following path: C:<UserAppDataDir>Xena<XenaTestApplication>. The <UserAppDataDir> directory depends on your Windows version.

The Xena test applications include a menu entry called Explore Xena Data Directory in the File menu that will open a Windows Explorer in the correct directory, regardless of the Windows version.



Debug Log Files

The Xena test applications logs certain events and errors to a series of debug log file located in the Logs subdirectory under the above mentioned main application data directory. If you encounter errors it may help the support if you include these files in your support request.
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Glossary of Terms


	Iteration
	Each test-type can be configured to repeat the test runs associated with the test-type a number of times. Each of these additional runs is called an iteration.



	Run
	Run     A “test run” (or simply “run”) denotes the part of the test configuration that is associated with a single test-type and a single packet size. This concept is used for the purpose of progress reporting. A test configuration that specifies the use of e.g. 5 packet sizes and has enabled 3 of the possible 4 test-types will thus consist of 5*3 = 15 runs.



	TPLD
	Test payload



	Trial
	A “trial” denotes a single execution of an iteration.
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Valkyrie3918

Valkyrie3918 Quick Start Guide
This short guide will help you get started using Valkyrie3818.

[

Add a Xena chassis to the current test configuration.

Select at least two ports in the Fhysical Ports panel at the left and drag them to the Selected Portz panel.

Change to the Test Configuration panel.

a. The General Test Options sub-panel contains options that affect all tests.

b. The Test Types Selection and Configuration sub-panel allow you to select and configure the exact set of tests you want to perform.

w

4. Configure the multicast roles for each selected port in the Selected Portz panel:
* You must set exactly one port as a Multicast Source.
« Each of the remaining ports must be set to either a Multicast Destination or Unicast Burdening Port role. You will need at least two burdening ports if you select one of the
tests in the Interaction group.
5. Setthe desired multicast flow options in the Multicast Configuration panel. If the selected tests require unicast traffic you will also need to visit the Unicast Configuration panel and
review these settings.
6. Review the reporting parameters in the Reporting panel and adjust these as needed.
Press the Start button in the toolbar to start the selected tests.

=

Further Assistance
For further assistance please refer to the online Xena help page which you can access by either selecting the Help -> Online Help menu item or by pressing F1
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This short guide will help you get started using Valkyrie3918.

-

Add a Xena chassis to the current test configuration.
2. Selectat least two ports in the Physical Ports panel at the left and drag them to the Selected Forts panel.

W

Change to the Test Configuration panel.
a. The General Test Options sub-panel contains options that affect all tests.
b. The Test Types Selection and Configuration sub-panel allow you to select and configure the exact set of tests you want to perform.

4. Configure the multicast roles for each selected port in the Selected Portz panel:
* You must set exactly one port as a Multicast Source.
« Each of the remaining ports must be set to either a Multicast Destination or Unicast Burdening Port role. You will need at least two burdening ports if you select one of the tests in the Interaction
group.
5. Setthe desired multicast flow options in the Multicast Configuration panel. If the selected tests require unicast traffic you will also need to visit the Unicast Configuration panel and review these settings.
Review the reporting parameters in the Eeporting panel and adjust these as needed.
7. Press the Start button in the toolbar to start the selected tests.

@

Further Assistance
For further assistance please refer to the online Xena help page which you can access by either selecting the Help -> Online Help menu item or by pressing F1

| (@ Test not running | Test Time: 00:00:00 | Duration: 00:00:00 | User: demo
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